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Introduction
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Background

Current Build 1.51.4645

This document covers supplementary information for version 1.51 It is in addition to the main manual shipped 

with version 1.50 and covers the differences between 1.51 and 1.50.  Over time this information will be 

incorporated into the main manual.

For a full list of new, updated and fixed features in ADE please read the Change Log.
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Release Notes

Below is a list of all changes, updates and fixes since version 1.50

New

      .. Added a Compile Button top right next to the Design Mode Selector.  This button is active when

         a project is loaded and when clicked will compile the project.

      .. The list of Taxiway names (Designators) is now presented in sorted order in the toolbar drop

         down.

      .. Center on Tower View point is now available from the Right Click Menu

      .. ToolTip  is available when mouse over Issues Button.  This will list current issues if any.

      .. Time to Next Auto Save Visual Indicator.  There is a countdown progress bar in the lower

         status bar area that displays the time left before the next auto save.  The color of the bar

         changes as the time counts down.  Auto save will only start when there are unsaved items in

         the project.

      .. ADE now supports Prepar3D as a separate Sim version.  This is reported as ADEP.

      .. A project tree that displays all user editable objects in a project.  Navigating the tree

         allows the user to find and/or edit objects.

      .. Moving Objects in front or behind each other has been extended.  Changes in this are now

         remembered by ADE.

      .. Night Lighting Mode.  ADE will now show the airport at night including all the lighting.  This

         is toggled on and off via the 'L' key. Most editing functions are available in Night  Lighting

         Mode.

Updated

      .. The Change Airport Altitude Tool will now ask if the user wishes to create a pre-load stub Bgl

         file for non stock airports.  Stubs ARE required for stock airport altitude changes so this

         option is not shown in this case.

      .. The Menu entry for List Libraries Used is now in the List Menu rather than the Tools Menu.

      .. The following flags can now be set for all Scenery Objects (Beacon, Effect, Fuel Trigger,

         Generic Building, Library Object and Windsock) :- No Autogen Suppression, No Crash, No Fog and

         No Shadow.

      .. Vertex display size can now be set by the user via Right Click > Display Options when a vertex
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         is selected.  The value set will also control the width of the edges drawn between vertices.

      .. Locked objects can now be copied and pasted.  The pasted copies are set unlocked.

      .. ADE now used the Geodesy Library for spatial calculations.  This should improve accuracy

         especially at high latitudes and where distances are long. Many thanks to motuslechat for

         pointing us to this library

      .. It should now be possible to move airports over longer distances accurately.  Thanks to

         motuslechat for pointing us to the Geodesy library created by Mike Gavaghan.

      .. If the user has Load Last Project on Startup set to true and this project causes ADE to fail

         to start then there is no simple way for the user to get ADE to start.  ADE will now turn off

         Load Last Project on Startup so that ADE can be started with no project loaded.

      .. ADE will now remember the compiled file name.  Currently this always resets to the default

         name each time a compile is carried out.  The default name will now only appear the first time

         a project is compiled or if it is not changed.  

      .. ADE now handles taxi links where either the start or end points are not found.  These errors

         cause the compile to fail.  On load ADE now checks for invalid taxi links and will remove

         them.  If user action invalidates a start or end point then the Issue Manager reports it and

         will fix the problem.  This should also deal with several CTD reports.

      .. The parking spot tool tip shows airline codes associated with the spot.  If there are more

         than five then the first five will be shown followed by '...'  This is intended to avoid over

         large tool tips.  In any case FS rarely honors more than a few airline codes at a spot.

      .. FSX Vehicle paths will always have a taxipath designator of BLANK

      .. FSX Vehicle paths are no longer highlighted when their  taxipath designator is selected.

      .. The display grid is now drawn based on a given spacing between lines.  The default is 500m

         (1500ft) however this can be set by the user.  The drawn grid is centered on the current

         airport reference point and extends 50km in each direction (100km x 100km). The grid can be

         toggled on and off via the 'G' key.

      .. User can now set the display color for a Flatten in FS9.

      .. User models are no longer described as Library Objects.  Both the tool tip and the property

         dialog now describe them as User Models.

      .. New taxi paths of type TAXI, PATH and PARKING now get a center line.  Note that new path drawn

         from an existing path take the properties of the parent (or origin path)

      .. The method for setting offsets for runway VASI/PAPI is changed.  Distances are now from the

         runway edge and from the runway threshold.
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      .. User Models can now be colored differently in the display to Library Objects.  A separate

         entry is available in the Color Settings Dialog to set the color for User Models.

      .. Most recently used (MRU) files method is changed.  The last saved project is now always at the

         top.  Different versions of ADE will no longer share the same MRU list.

      .. Tools menu is now accessible when no project is loaded

      .. It is now possible to set the pushback direction for parking spots.  Note this is not honored by

         FS but use is made of the property by some third party products.

Fixed

      .. Problem that stopped user from deleting all airline codes from a multiple selection of parking

      .. The Issue Manager will now report an error if a parking spot is identified with a Parking Type

         of NONE.  The compiler will fail if this is not corrected

     .. CTD when trying to add a Fuel Trigger in ADEX.  Probably caused by more than one object being

         selected or an unexpected double click.

      .. Multiple selection of vertices using the Shift Key now works.  It is possible to drag and/or

         delete multiple vertices.  Rubber band selection of vertices is currently not possible but is

         planned for a later release.

      .. CTD when trying to delete an object.  This is reported as an Index Out of Range error and was

         caused by the drawing code.

      .. It is now possible to Undo adding a Jetway in ADEX

     .. The appearance of the 'Delete Failed' message should no longer occur.  This was a bug caused

         by selecting an object and hitting the delete key more than once.

      .. VOR/ILS without idents result in a compiler error.  The Issue Manager now identifies these and

         will allow the user to fix them.  It is no longer possible to create a VOR or ILS without an

         ident. It is no longer possible to edit a VOR or ILS to remove the ident.

      .. NDB without idents result in a compiler error.  The Issue Manager now identifies these and

         will allow the user to fix them.  It is no longer possible to create an NDB without an ident.

         It is no longer possible to edit an NDB to remove the ident.

      .. Bug that caused display to pan at greater rate than the mouse move after disconnecting from

         FS.

      .. The Issue Manager now reports any parking spot airline codes that exceed four characters in

         length.  Any codes over four characters will cause a compiler error.
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      .. ADE will now report if an Effect file used in a placed effect cannot be found. Shows a Red

         line and appears in the Tooltip as a problem

      .. Cardinal runway idents are now displayed properly in ADE.

      .. Rubber band does not work over Background Image.  The method of selection for images is

         changed to fix this problem.  Selection is now possible only on the edge.

      .. CTD where ADE is trying to open the users default internet browser and cannot.

      .. CTD when trying to list Taxi Paths.  Caused by invalid taxi name index values for non-runway

         links

      .. Inconsistencies and errors generated in Starts, ILS and taxi links when a runway is

         re-numbered.

      .. CTD when trying to edit an object by using double click in the List View

      .. Issue where ADE reports wrong library object footprint size in property dialog where dimension

         units are set to feet.

      .. Incomplete undo/redo for Starts, ILS and taxi links when a runway is renumbered

      .. The Start Tooltip now shows the full Runway Ident including the designator letter if present

      .. CTD when trying to edit an Effect and the Effects Folder was not correctly identified

      .. CTD when trying to add Marker beacons when there are no runways at the airport
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New Features



Copyright 2012 ScruffyDuck SoftwareADE 1.51 Supplementary Manual - 10

Center on Tower View Point from Right Click Menu

Center on Tower View point is now available from the Right Click Menu.

The tower viewpoint is off center of the display (1).  In 

may well be off screen.  To move the tower viewpoint 

to the center of the display:  Right Click and Select 

'Center on Tower Viewpoint' (2).

The display will redraw and place the tower view point 

at the center. If there is no tower viewpoint in the 

project then the menu action will have no effect.
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Change the Object Display Order

Moving Objects in front or behind each other has been extended.  Changes in this are now remembered by ADE.

Find the current Drawing Layer

Move the cursor over an object and the tooltip will 

show the current drawing layer.  In this case the tower 

object is in layer 39. 

It is over the tower view point that is currently in layer 

40.  
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 Change the Order using Menus

To move the tower view point in front of the object:

• Select the Tower Viewpoint

• Right Click

• Select either Move Forward or Move to Front.

Selecting Move to Front brings the Tower Viewpoint into 

the top layer (layer 4).  Alternatively you could select the 

tower object and use either Move Back or Move to Back.

ADE will remember these changes when you save and 

load the project file again.

Change the Order using the Keyboard

A quick alternative to the menu is to use keyboard short cuts to change the order 

of the selected object:

• Move  Forward - Ctrl + Home

• Move Back - Ctrl + End

• Move to Front - Alt + Home

• Move to Back - Alt + End
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Compile from the Toolbar

Compile Button top right next to the Design Mode Selector.  This button is active when a project is loaded and 

when clicked will compile the project.

The Compile Button provides an alternative to File > Compile or 

Ctrl+C to start the compile of an airport.  The button is only active 

if a project is loaded.
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Night Lighting

Changing ADE to show a view of the airport at night.

Change Day/Night using the Menus

Select the View Menu.  The Night Lighting entry is a Toggle that sets night 

lighting on or off.  In this case Night Lighting is off, so clicking the menu 

entry will set it on.

This shows the menu entry checked and Night Lighting will be on.  Click it 

again to turn Night Lighting off.
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The airport at night showing the lights.  Most objects 

can still be selected edited, moved and so on in this 

mode.

Change Day/Night using the Keyboard

Pressing the 'L' key will toggle the day/night mode.  It will also set the check 

status of the menu item so the two methods are inter-linked.
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Project Tree to Edit Airport Items

 Project Tree that displays all user editable objects in a project.  Navigating the tree allows the user to find 

and/or edit objects.  This provides an alternative to individual lists and also provides access to some airport 

elements that are not available in another list view.

Open the Project Tree

To open the tree select the Lists Menu and Project Tree .
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The tree (1) will start with the groups of objects 

closed.  Select any group to open it.  The Tree groups 

similar objects together to make them easier to find.  

If you want to find a specific object in the display then 

use the Find button (2).  Clicking the Edit button (3) will 

open the appropriate properties dialog to allow the 

object to be edited.

Find an Item

1. Select an item

2. Click the Find button

3. ADE selects the item and centers the display on it.
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Edit an item

1. Select the item in the tree

2. Click the Edit button

3. ADE will open the properties dialog to allow the 

item to be edited.
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Quick View of Issues in Issue Manager

A Tooltip  is available when mouse over Issues Indicator.  This will display a list of any current issues that will 

stop the project from being compiled.

The Issue Manager Indicator

The Issue Manager tracks the state of the project in 

the background as you work.  If an issue is detected 

that would cause the compile to fail then the 

indicator (1) will change color to Red.  Clicking the 

indicator when it is Red will open the issue manager 

and allow you to fix the problems.

The Tooltip with No Issues

The indicator is Green indicating that no fatal issues have been found.  Hover the 

mouse over the indicator and the tooltip provides confirmation.

The Tooltip with Issues

The indicator has turned Red.  Hovering the mouse 

over the indicator displays the tooltip listing a 

summary of the issues found.  The tooltip will show 

only the first few issues so there could be more

Deal with the Issues 

Click the Red indicator and the Issue Manager will 

open.  From here you will be offered some help and 

advice on how the issues may be fixed.
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Using ADE with Prepar3D

Starting and using ADE with Lockheed Martin's Prepar3D (P3D).  Each simulator version is treated entirely 

separately in ADE.  They have their own settings, databases and so on.

Select the Version

Start ADE in the usual way from the short cut link or executable.  When the 

version chooser appears, click the drop down list.  This list displays the available 

versions of FS on the computer.  If P3D is present  (ADE will look in the registry) 

then it appears on the list (1).  Select it and click the OK Button (2).  ADE will now 

load for P3D.

Run ADE for P3D for the First Time

If you have not run ADE for P3D (ADEP) before then the 

New User Wizard  will appear.  It is essential  that you 

do not bypass this if you want ADE to work properly.  

Click the Next Button to get started.
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Set the General Settings

1. Enter your initials in the box provided.  These will 

be used in things like the file name and are helpful 

in identifying the project and compiled files.

2. Some messages appear for a short time before 

they leave the screen.  The default setting usually 

works fine.  If you want to change this or any other 

setting later you can do so by using the menus 

(Settings > Options).

3. ADE backs up your work at regular intervals.  A new 

feature of ADE 1.51 is a count down bar that shows 

how long it is to the next autosave.  The default 

here of five minutes works for most people but you 

may change it to suit your needs.

4. There is a bug in FSX (and also P3D) that affects the 

drawing of apron links that do not (should not) 

display a surface.  Unless you want to manually 

handle link surfaces for Apron Links then leave this 

ticked.

Set the P3D Folders

The best way to set the required folders is to clich the 

Find Button.  ADE will search the registry for entries for 

P3D and the P3D SDK.  If it finds them then the correct 

entries will be shown in the dialog boxes:
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If however the entries in the registry for P3D and/or its 

SDK are not correct then the entries will show the ADE 

application folder and not the correct folders.  

Generally the best way to avoid any future problems 

is to fix any registry errors.  However ADE provides a 

manual method to set these folders.

Clicking these buttons will open a folder browse dialog so that 

you may find the folder yourself.

Set you Preferred Units

You can set you preferred units of measure:

1. Distance

2. Dimensions

3. The radius of parking spots

4. Altitude

5. Latitude and Longitude



Copyright 2012 ScruffyDuck SoftwareADE 1.51 Supplementary Manual - 23

Finish the New User Setup

Click the Finish Button to complete the process.  

NB.  Although ADE should remember your settings at 

once it is recommended that you close and re-open 

the application before starting work.

Opening the New User Wizard at a Later Date.

You can open the new user wizard at any time but using the Tools Menu 

and selecting New User Wizard
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Visual Indicator of Time to Next Autosave

There is a countdown progress bar in the lower  status bar area that displays the time left before the next auto 

save.  The color of the bar  changes as the time counts down.  Auto save will only start when there are unsaved 

items in  the project.  This is a useful visual indicator when working on a project since ADE will stop taking user 

input for a short time while the autosave is in progress.

There is more than 50% of time left before the next autosave.  

Using the default autosave setting there is between 5 minutes 

and 2.5 minutes to the next autosave

There is less than 50% of time left but nore than 25%,  Using the 

default setting there is between 2.5 minutes and 1 minute 15 

seconds to the next autosave.

The next autosave is getting close.  Using the default setting there is less 

than 1 minute 15 seconds left.

Set the Autosave Interval

To change the autosave interval open the Options Dialog from the Settings 

Menu

1. Make sure that the General Tab is open

2. Use the arrows or enter a new autosave interval

3. Click the Save button

Note that when you change the autosave interval; 

that the count down timer will start again.
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Updated Features
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Airline Codes in Parking Spot Tooltip

The parking spot tool tip shows airline codes 

associated with the spot.  If there are more than five 

then the first five will be shown followed by '...'  This is 

intended to avoid over large tool tips.  In any case FS 

rarely honors more than a few airline codes at a spot.
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Background Display Grid

The display grid is now drawn based on a given spacing between lines.  The default is 500m (1500ft) however 

this can be set by the user.  The drawn grid is centered on the current airport reference point and extends 

50km in each direction (100km x 100km). 

Display/Hide the Grid using the Menu

The grid is visible in this screen shot

To hide the grid select the View Menu and Grid.  
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This will uncheck the mark and the grid will be hidden.

Display/Hide the Grid using the Keyboard

The 'G' Key will toggle the grid on and off.  The key is interlinked with the menu 

item so the state if the menu item is changed when the G key is used.
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Change Airport Altitude

The Change Airport Altitude Tool will now ask if the user wishes to create a pre-load stub Bgl file for non stock 

airports.     A non stock airport is one that is created by a user and that has a user defined Ident that does not 

match any stock airports.

Stubs ARE required for stock airport altitude changes so this option is not shown in this case.  Changing the 

altitude of a stock airport requires that a Bgl file containing the new altitude value is loaded by FS before the 

stock airport.  ADE creates the stub Bgl to do this.

Change Airport Altitude using the Menu

Select the Tools  menu and Change Airport Altitude

Change Airport Altitude for Stock Airport

If the airport is a stock airport then ADE will show this 

dialog.  A stub Bgl is required so there is no option in this 

case.
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Change Airport Altitude for Non Stock (User Created) Airport

If the airport is not stock - that is an airport created by the 

user that has an Ident not in the stock list - then ADE now 

offers the option of creating a stub.  By default this is 

turned off since it is not required.  However for some 

advanced users who may have several Bgl files related to 

their airport then having a Bgl file that they know will load 

before anything else may be of benefit.
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Set Display Properties for Vertex

Vertex display size can now be set by the user via Right Click > Display Options when a vertex is selected.  The 

value set will also control the width of the edges drawn between vertices.  Making the line width smaller can 

help in working with vertices when zoom levels are high.  ADE will remember the setting until you change it 

again.

Select a Vertex

Select a vertex and open the Context Menu (Right Click 

with the vertex selected)

Click Display Options  to show the dialog
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This vertex has a line width setting of 2

This is the default size
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Change the Size Value

1. Change the size to 0.5

2. Click Close

The vertex is now drawn with a smaller border and the 

edge lines for the selected apron as also reduced. 
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Set Flags for Scenery Objects

The following flags can now be set for all Scenery Objects (Beacon, Effect, Fuel Trigger, Generic Building, Library 

Object and Windsock) :- No Autogen Suppression, No Crash, No Fog and No Shadow.

Open the Properties for a Scenery Object

Select a library Object and use the Enter Key to open 

the Property Dialog.  The Flags List (1) is showing that 

no flags are set.  To set them click the small down 

arrow (2)

Select the Flags to Apply to the Object

Four flags are available and none are set.



Copyright 2012 ScruffyDuck SoftwareADE 1.51 Supplementary Manual - 35

Select one or more flags by clicking the checkbox.  It 

may be necessary to click twice to get the first box to 

accept a check mark.  To clear an existing flag do the 

same thing.  Clicking on a checked box will clear the 

checkmark and unset the flag.

Close the list by clicking anywhere on the dialog and 

then OK to ave the changes.



Copyright 2012 ScruffyDuck SoftwareADE 1.51 Supplementary Manual - 36

Set Offset for VASI/PAPI

The method for setting offsets for runway VASI/PAPI is changed.  Distances are now from the runway edge and 

from the runway threshold.  In the original methods distances were from the center point of the runway.

The Old Method

1. The distance from the center line of the runway to the position of the VASI/PAPI

2. The distance from the runway center point to the position of the VASI/PAPI
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The New Method

1. The distance from the runway edge to the position of the VASI/PAPI

2. The distance from the runway threshold to the position of the VASI/PAPI
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Set the VASI/PAPI Position

1. Set the distance of the VASI/PAPI from the runway 

edge

2. Set the distance of the VASI/PAPI from the runway 

threshold
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Set Pushback Direction for Parking Spots

Pushback direction is not honored by FS, so past versions of ADE have not provided access to this property.  

However some third party products make use of this value so it can now be set for one or multiple parking 

spots

Select Parking Spot(s)

Select one or more parking spots.

Open the Properties Dialog

Hit the ENTER key to open the property dialog.  The 

current push back direction is shown in the middle of 

the dialog (1).  

Note that Tee Offsets are not available in ADE9 (2).
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Change The Pushback Direction

To change the direction click in the drop down and select a new direction from the list.

Save or Cancel the Changes

Click OK (1) to save your changes or Cancel (2) to 

ingore them.
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User Model Display and Tooltip

User Models can now be colored differently in the display to Library Objects.  A separate entry is available in 

the Color Settings Dialog to set the color for User Models. User models are no longer described as Library 

Objects.  Both the tool tip and the property dialog now describe them as User Models.

User Models

User models are object models created by users and 

added to a project as an mdl file.  In this case we have 

a named model that has been used once in the project

1. When placed in the project the model has a color 

that is user defined and separate from the color 

used by Library Objects in a library Bgl file.

2. The desciption in the Tooltip is now User Model
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